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INTRODUCTION 

ABC Planner: the concept 
ABC Planner™ is an entry level Decision Support System designed to solve planning, scheduling 
or costing problems. It works on top of a world-renowned simulation engine, AutoMod™, a 
discrete-event simulation package that is recognized for its flexibility and speed of execution. 
Enabling one to do multi-criteria simulations, ABC Planner combines ease of use with a powerful 
simulation engine. A user can quickly develop, test and analyze different industrial or business 
scenarios. With minimum effort, requiring no technical expertise, one can represent an actual 
work environment (with a model) and execute all company activities and operations in high-
speed simulation mode. The results of a simulation enable one to foresee the events and 
consequences of all activities of the analyzed process. Therefore, intelligent decisions can be 
made based on results to achieve greater productivity at the least cost. 

ABC Planner uses technologies and functionalities similar to ones found in AutoSched™, a full 
scale industrial finite capacity planning and scheduling software used by Fortune 500 companies 
for planning and scheduling. ABC Planner can be successfully applied to a wide variety of 
environments (manufacturing and services) and processes (fabrication, industrial, administrative). 
Taking advantage of user-defined entities, the specific vocabulary of a company or profession 
can be used in ABC Planner's headers, making it extremely familiar and easy to use. Similarly, 
the reports can be tailored with custom headers and contents. English and French language 
support is built-in; other languages can easily be added. 
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Welcome Window 

Applications of ABC Planner 
ABC Planner can be tailored to the “language” used in your business or industrial situation. 
Indeed, what traditional simulation tools call a “resource” can more easily be identified by 
“machine”, “doctor”, “pilot”, “vehicle”, etc. depending on the situation. 

The following list presents some possible applications of ABC Planner: 
- capacity planning (e.g. : # work centers in a factory, # beds in an hospital) 
- finite capacity planning and scheduling 
- Activity Based Costing – ABC 
- simulation of Business Process Reengineering scenarios 
- short, medium and long term forecasting 
- simultaneous management of projects (with Gantt IT™) 

 

Decision support with ABC Planner 
Performance measures in ABC Planner’s reports provide information on: 

- quantities (e.g. : inventories) 
- duration (e.g. : mean time per order) 
- costs and added value (e.g. : expected inventory cost for a specific order) 

All these measurements are collected during a simulation run by “virtual instruments” embedded 
in the simulation engine. Measurements are instantaneous (e.g. : step report for an activity, 
periodic inventory status) or computed at the end of the simulation (e.g. : average, current and 
total quantity of items in inventory). 

ABC Planner supports multi-dimensional accounting analysis using these metrics. Analysis can 
be made at different levels of aggregation, and intangibles as well as opportunity costs, that may 
be difficult to evaluate using static spreadsheets, can be estimated. 

 

What is discrete-event simulation? 
Discrete-event simulation is the missing link in the structure of traditional spreadsheet 
applications. Discrete-event simulation allows one to consider the time dimension in any 
functional, operational or economic evaluation. 

Indeed, with simulation, the dynamic behavior of a system as well as the interactions between its 
components can be studied over a period of time and unexpected situations can be easily 
identified. Applied to discrete systems (i.e. the opposite of continuous processes such as chemical 
manufacturing plants), simulation is used for the designing of new facilities (plants, hospitals, 
airports, etc.), emulating the behavior of systems to validate the control algorithms, as well as 
managing these facilities (planning, scheduling, and even real time dispatching). 

When compared to Monte Carlo simulation, often given in example for explaining simulation, 
discrete-event simulation (the approach chosen for ABC Planner) uses a more realistic model of 
the system studied and allows for more detailed analysis. 
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A simulation calendar is used to manage discrete events, which are sequenced according to their 
date of occurrence and respective priority. Every time an event is executed, the interactions 
between the components of the systems are modified and new events are added to the calendar. 
As the simulation goes on, the “virtual instruments” keep on updating and compiling the 
performance measurements. 

The key interest of simulation is its unique ability to evaluate the dynamics of a system without 
disturbing its operation or even before it exists. One can quickly establish the short term and long 
term impact of changes made to the system without risking a major problem. “What ifs” are thus 
made easier and analysis becomes more accurate due to the time dimension, which allows the 
representation of seasonal demand and dynamic interactions between internal and external 
elements.  
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CHAPTER 1: INSTALLATION 
Please read the file “readme.txt” for the last minute changes and FAQ. 

 

1.1 Installing and using ABC Planner Version 2.0 for the first time 
Insert the CD-Rom labeled ABC Planner into the drive; the automatic installer should start within 
a few seconds. 

If the installer does not start, follow these steps: 

1. From Windows Explorer or File Manager, double click on “abc_init.exe”  

2. Follow the installation steps 

3. AutoMod installation: 

• Administrator right is needed for Windows NT/2000 to install AutoMod. 

• If AutoMod is already present on the computer ABC Planner is being installed to, you 
may select "Skip" in the AutoMod installation dialog to continue using the current 
version (provided the version is 9.1 or later), otherwise select "Next" and install 
AutoMod Version in a different directory. 

• You will be required to restart your computer after AutoMod has finished installing.  
ABC Planner's installer will continue after rebooting 

 
N.B.: To change version of AutoMod you need to change the system variable. Also please be aware that although 
ABC Planner version works on top of all current versions of AutoMod including the Student Version. Brooks Inc. 
strictly prohibits the use of the AutoMod Student Version for non-educational purposes. 

For NT/2000 (Start/Settings/Control Panel/System/Environment/Advance), select ASI, change the value (ex: 
am_100), set, apply and reboot the computer.  

For 95/98 (Start/Run) type sysedit, select the autoexec.bat change the value of set ASI = to the new value and reboot 
the computer. For information regarding AutoMod see AutoMod’s reference book on page 6.  

 

The user must use the Parameter Form if he changes, after installation, the directory of one of the 
applications used by ABC Planner or the location of ABC Planner itself in order to provide the 
new path. The appropriate path of the referenced applications must be entered in the Parameter 
form. The ABC Planner application path must be entered in the ABC Planner Path field. The 
AutoMod, Acrobat and Excel paths must be entered in their respective fields. Be sure to enter 
the name of the executable at the end of the path as shown in the Figure that follows. The 
Excel File Path field contains the path of the DataReport.xls file provided with ABC Planner. It is 
recommended that this file be in the same directory as ABC Planner. Finally, Gantt It Path must 
also be provided (if Gantt IT is installed) in order to indicate ABC Planner its location on disk 
(the path must contain the executable name). 

The Parameter Form can be accessed by selecting the Parameters Item from the View Menu. 
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The Link HTML Files button (command which can also be launched from the File Menu) must 
be used only during an initial installation or when ABC Planner, or the HTML files provided 
with it, has changed locations. ABC Planner comes bundled with 19 HTML files, which are used 
to display reports. It is recommended that these files stay in the same directory as the application. 
It is necessary for ABC Planner to know where these files are situated in order to launch them 
from the application. It is also necessary for the HTML files to know where ABC Planner is 
located in order for them to retrieve the information they need to create reports from the 
application. This command precisely indicates both to the application and the HTML files where 
they are respectively located on disk. 

 

 
Parameter Form 
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To create a new model, follow these steps:  

1. Start ABC Planner 

2. Select File => New Model 

3. Select the path and the model name in the pop-up Dialog 

Note: It is impossible to have two models in the same 
directory 

 Model names must be continuous and therefore 
cannot contain spaces or tabulations 

 

To open an existing model: 

1. Select File => Open Model 

2. Select the *.mfi file in the model directory 

 

1.2 Files copied to the hard drive during the installation  
- ABCPlanner : Directory containing files related to ABCPlanner 
- ABCPlanner.mdb : ABC Planner Executable/Database file 
- simcost.arc : Directory containing simulation logic 
- Models : Directory containing ABCPlanner models/Demos 
- Package : Directory containing files needed for the installation 
- DataReport.xls : Excel file used to display report data 
- AutoMod : AutoMod executable and related files 
- Gantt It : Gantt It executable and related files 
- *.htm files : Multiple .htm files used to display reports 
- help.pdf : user’s manual (this document) 
- aide.pdf : user’s manual (French) 
- readme.txt : last minute changes and hints 
- lisezmoi.txt : last minute changes and hints (French) 
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CHAPTER 2: COMPONENTS AND INTEGRATION 

2.1 Overview of the simulation engine  
ABC Planner’s simulation engine runs in finite capacity mode. Finite capacity means that it is 
impossible to overload a resource or to use a resource that is not available. This approach is 
closer to the reality of most industries, services and business activities, than the close-finite or 
infinite capacity modes offered by most time-buckets based approaches. Finite capacity with 
ABC Planner also means coordinating resources to work together towards the completion of an 
activity, and considering individual work calendars. 

With ABC Planner, activities are ranked and executed by order of importance according to the 
decision rule associated with each individual resource. 

ABC Planner’s simulation engine, AutoMod, can be configured to use global and local decision 
rules. When used in conjunction with ABC Planner, AutoMod is started and stopped 
automatically through ABC Planner’s interface. AutoMod can also be used without ABC Planner 
to perform any kind of simulation study, including material handling and warehousing studies. 

 Information regarding AutoMod can be obtained from MultiCIM’s web site:  
- http://www.multicim.com 

or directly from Brooks Inc web site: 
- http://www.automod.com 

or by phone: 
- (514) 633-6401 (MultiCIM – Canada) 
- (801) 736-3201 (Brooks Inc. – USA) 

 

2.2 Analysis Center - Gantt IT™ 
The analysis center’s role is to provide an easy way to analyze the sequence of activities 
generated by ABC Planner with Gantt IT™, while ABC Planner’s report viewer is used to present 
performance information from an operational and economical point of view. The analysis center 
is to be used by planners and schedulers whom would like to review and analyze the proposed 
sequence of activities through Gantt charts (with Gantt IT™) or activity reports. The sequence 
can then be sorted and printed by workcenter, order or product type. 

 

2.3 Compatibility and integration issues  
Data and reports files are ASCII flat files and can be accessed/imported/generated/modified using 
any other application, as long as the expected file format (headers, # of columns and order of 
columns) is respected. For more information regarding integration and/or automatic simulation, 
please contact MultiCIM. 
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CHAPTER 3: OVERVIEW OF THE INTERFACE 
ABC Planner menus are bilingual (French and English) and the interface can be partially 
customized by the end user. The headers of data sheets (input files) and reports (output files) can 
be tailored for each project. 

The interface provides traditional menus found on top of the application. Beside these menus, a 
toolbar floating on top of the application provides a way for the user to switch back and forth 
from the three ABC Planner zones: Data Entry Zone (DEZ), Scenario Zone (SCZ) and Data 
Report Zone (DRZ). The first button on the Data Access Menu bar and the first item of the View 
Menu enable the user to open this floating Main Menu. The top View Menu provides the same 
ability to navigate back and forth through ABC Planner’s zones.  

 

 

Button & Menu 
Command used 

to open the 
Floating Menu 

Data Access 
Menu 

Floating 
Menu 

Data Entry Zone (DEZ), accessed 
by selecting the Model Data Item 
either from the Floating Menu or 

the View Menu 

Data Entry Zone (DEZ) 

 

One can access the Data Entry Zone (DEZ) by clicking either on the Model Data button of the 
Floating Menu or by selecting Model Data from the View Menu as shown in the previous Figure. 
The Scenario Zone (SCZ) of ABC Planner is access by clicking the Scenarios/WIP button from 
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the Floating Menu or by selecting the Scenarios/WIP Sub-Menu from the View Menu, while the 
Data Report Zone (DRZ) is reached by either selecting the Reports Button or the Reports Item 
from the Floating Menu or the View Menu respectively.  

 

 

Scenario Zone (SCZ), accessed 
by selecting the Scenarios/WIP 
Item either from the Floating 

Menu or the View Menu 

Scenarios Zone (SCZ) 
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Data Report Zone (DRZ), 
accessed by selecting the 

Reports Item either from the 
Floating Menu or the View 

Menu 

Data Report Zone (DRZ) 

 

ABC Planner – Version 2.0 User’s Manual 10 

Copyright 2004 -–MultiCIM Technologies Inc.                         http://www.multicim.com/ 



 

 
Contextual Help 

 

The user can obtain contextual help regarding a model data field by pressing the F1 key when 
position on the field for which he whishes to have information. 
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3.1 Menus 

Floating Menu & Data Access Menu 
As mentioned in the previous preamble, the Floating Menu contains buttons enabling the user to 
move back and forth from the three ABC Planner zones (DEZ, SCZ and DRZ). It is also possible 
for the user to switch from these three zones by using the Data Access Menu, indicated on the 
first Figure of the present chapter. The first button on the Data Access Menu bar and the first item 
of the View Menu enable the user to open the Floating Main Menu. The top View Menu provides 
the same ability to navigate back and forth through ABC Planner’s zones. 

The Floating Menu also contains a button used to launch a Simulation and a button to launch 
Gantt It. It is also possible to launch a Simulation from the Run Simulation Sub-Menu of the Run 
Menu. The Run Menu provides a second way to launch Gantt It. 
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Window enabling one to import Simulation Results 

 

When a model is open, the user can import simulation results by clicking on the “Import Data” 
button. ABC Planner will ask the user to precise which data he whishes to import (Planning or 
Scenarios)? 
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File menu 
New model 

Used to create an ABC Planner Model. It gives access to a dialog window where the user 
can navigate in the directory structure and save his new model under the name he has 
chosen (WARNING: spaces and special characters are forbidden characters in a model 
name). There can only be one model per directory to prevent data files from being 
overwritten between models. Once the user validates the selected name of the Model, ABC 
Planner creates a folder in which the Model and its associated files will be saved. If ABC 
Planner already as a Model open and the user tries to create a new model, ABC Planner 
will ask the user to close the opened model prior to creating a new one. 

Open model 
When chosen, ABC Planner opens a dialog window where the user can look for an existing 
model. Once in the appropriate directory, the user must choose the NameOfModel.mfi file. 
If ABC Planner already has an open model, and the user tries to open a second model, ABC 
Planner will ask the user to close the opened model prior to opening a new one. 

Close model 
Allows the user to close the current model. By selecting this Menu Item, ABC Planner 
exports the data contained in the tables of the application to text files and empties ABC 
Planner’s database, enabling the user to open another Model. The user does not have to 
close a model before exiting ABC Planner. The data will automatically be conserved in the 
database. The user needs to close a model only when he wants to create or open a new 
model. 

Compact Database 
It is recommended to use this function once in a while, depending on the size of one’s 
model and the frequency of Simulations. Access, the database on which ABC Planner is 
built, accumulates a large amount of unnecessary data when exporting and importing data 
to and from text files (which occurs every time a simulation is launched). Thus, the size of 
the database will grow in size every time a simulation occurs. It is therefore necessary to 
compact the database once in a while in order to eliminate its unnecessary data in order to 
maintain a small or medium size database. The user should verify the initial size of its 
model and verify at times, to see if its size as grown by multiples of its original size. In this 
case, he should launch a compacting process (which takes only about half to one minute). 

Link HTML Files 
This command must be used only during an initial installation or when ABC Planner or the 
HTML files provided with it have changed directories. ABC Planner comes bundled with 
19 HTML files, which are used to display reports. It is recommended that these files stay in 
the same directory as the application. It is necessary for ABC Planner to know where these 
files are situated in order to launch them from the application. It is also necessary for the 
HTML files to know where ABC Planner is located in order for them to retrieve the 
information they need to create reports from the application. This command precisely 
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indicates to both the application and the HTML files where they are respectively located on 
the disk. 

 

Exit ABC Planner 
Closes the application. 

 

View menu 
Main Menu 

Opens the Floating Menu. The items figuring on the Floating Menu are detailed in the 
“Floating Menu & Data Access Menu” sub-section here above. 

Model Data 
Opens the Data Entry Zone (DEZ). The DEZ zone is used to create a model representing 
one’s manufacturing or business process. The information needed to create a model is 
detailed in Chapter IV. 

Scenarios/WIP 
Opens the Scenario Zone (SCZ). The functions related to this zone are explained in Chapter 
VII. 

Reports 
Opens the Data Report Zone (DRZ), explained in Chapter VI. 

Excel Reports 
This command enables the user to access two sub-menus; the Export Data in Excel and 
View Data in Excel menus. The sub-menus are used to export the Reports Data generated 
by the simulation into Excel and then launch Excel from ABC Planner in order to analyze 
these data from within this application. The View Data in Excel Menu opens the 
DataReport.xls file, which is provided with ABC Planner. The Excel file contains a macro, 
which is launch upon opening if the user has macros enabled in Excel or if he chooses to 
execute them. The macro displays the data in a preformatted way that facilitates the 
analysis of the simulation data. 

Parameters 
Opens the Parameter Form. Please refer to Chapter I regarding installation for more details 
concerning Parameter Form. 

Select Language 
Enables the user to select the language he prefers (only English and French at the 
moment). The menu items, the messages in dialogs and the help will be in the selected 
language. It is also possible for the user to choose the name of the column headings in 
both the Data Entry Zone (DEZ) and the Data Report Zone (DRZ) he whishes, by opening 
the Parameter Form and then clicking the Headings button. 

User and Group Permissions 
Used to manage user’s rights. 
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Run menu 
Run Simulation 

Initiates the simulation in three steps: 
1. the data are exported from ABC Planner to text files; 
2. a dialog window appears asking for: 

- the simulation start date and the simulation duration; 
- the period in hours for continuous reports (0 means no report); 
- the random stream index (any value between 0 and 99). 

3. AutoMod is launched and the simulation is run; 
See chapter 5 for more details 

Launch Gantt It 
Launches Gantt It with the data from the last simulation. See Chapter VIII for more details. 

Stop Execution 
Orders ABC Planner to stop waiting for the execution of the simulation. This Command 
will only tell ABC Planner to stop waiting for the results from AutoMod, which is executed 
in parallel. By selecting this Item, AutoMod will not be notified of the Command to stop its 
execution. The user must maximize the AutoMod execution window (if it is available) 
figuring in the state bar at the bottom of the window and manually stop the execution 
himself. 
The user should use this command only when encountering a problem with the simulation 
process. Some logical errors in the construction of the model can be passed to the 
simulation engine (AutoMod) without being noticed. In some cases, these errors can make 
AutoMod crash without returning the control to ABC Planner. In these cases, ABC Planner 
will be waiting indefinitely for the response of AutoMod, indicating that the simulation has 
finished. Thus, the user has to manually indicate to ABC Planner that the simulation has 
terminated. In some rare cases it might be necessary for the user to use the Task Manager of 
Windows. Pressing and holding the Ctrl, Alt and Delete keys at the same instant can access 
this utility. Once the dialog appears, one must select the Processes Tab and then the 
amod.exe execution. Once selected, the End Process button must be clicked to definitely 
stop the execution of AutoMod. 
The user can close the Simulation Parameters Dialog appearing just before launching 
AutoMod (seen in the next Figure) without clicking on OK if he whishes not to launch the 
simulation process. ABC Planner will not execute the simulation process when the Dialog 
is closed without confirming OK. 
Clicking on the Stop Simulation button will only indicate ABC Planner to stop waiting for 
the results of the simulation and will not stop the launching process regardless of when it 
was clicked. This limitation is a way to preserve data integrity in the database and eliminate 
loss of data due to unfinished procedures that would result from stopping the execution 
process at any time. One has to note that the data are exported and imported to and from 
text files external to ABC Planner. 
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Simulation Parameters Window 
 

 
 

Calendar used to precise Simulation Start Date 
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Help menu 
ABC Planner Help 

This Item launches Abobe Acrobat’s Reader with the present document. If the selected 
language is English the present document will be opened, while if it is French, the French 
Help will be launched. 

Contact Technical support 
Opens a composition box with the default e-mail application used on the system in order to 
contact MultiCIM and get technical support for ABC Planner. 

MultiCIM Technical support 
Opens the default Browser of the system and connects to MultiCIM’s home Page. 

Get Latest Version 
Opens the default Browser of the system and connects to MultiCIM’s ABC Planner 
download page. 

About this Program 
Credits for the development of the software and Copyrighted statement regarding the 
Application. 

Contextual Help 
One can get information regarding any field in the Data Entry Zone (DEZ) by positioning oneself 
on the field and pressing F1. A dialog will open containing information related to the field on 
which the cursor is presently positioned. If the selected language is English the information will 
be displayed in English, while if French is selected as the preferred Language, the information 
will be in French. 

 

Column headers 
The column headers of the Data Entry Zone (DEZ) and the Data Report Zone (DRZ) can be 
modified by opening the Parameters Form and then the Headings Form. 
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CHAPTER 4: DATA FILES 

4.1 Data Organization 
There are three categories of information in ABC Planner: 

1. resources and calendars 
2. products or services 
3. orders lists 

 
# Sheet Tab name Description 
1 dept.txt dept List of departments 
2 stock.txt stock List of storage areas 
3 stn.txt stn List of workstations 
4 shifts.txt shifts List of shift calendars 
5 holidays.txt holidays calendar of holidays 
6 exceptions.txt exceptions calendar of exceptions (failures or illness for ex.) 
7 downs.txt downs List of downs (Preventive Maintenance for ex.) 
8 tool.txt tool List of auxiliary resources (tools, operators) 
9 part.txt part List of products, services or customer classes 

10 route.txt route List of production/service activities per product type 
11 bom.txt bom List of components types and quantities per assembly step 
12 order.txt order List of stock/customer orders 
13 supply.txt supply List of orders to be received 
14 syst.txt syst general information (overhead costs) 
15 comm.txt comm user information 

 

Resources and calendars (sheets 1 to 8)  
Resources are the components of the system used to produce goods and services. Examples of 
resources in different environments include: 

Factory Bank Hospital Transport
- machines - cashiers - physicians - trucks 
- operators - managers - nurses - planes 
- tools - computers - bedrooms - docks 
- vehicles - bank vault - scanners - cranes 

Resources can be viewed as main elements used to add value (or cost) to a product or service. 
Most of the time resources are available in limited quantities, meaning that some products or 
services can be delayed by an unavailable resource (e.g. people waiting in line at the bank). 

Resources can also be grouped by “affinity” (e.g. type, process, etc.) in a system. These groups 
are sometimes called cells, departments or services (sheet 1 and 2). 
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Some activities require the use of more than one category of resources simultaneously. ABC 
Planner can consider auxiliary resources (sheet 8). 

Calendars (sheets 4 to 7) are used to specify the periods of availability for resources. Fixed 
periods such as shifts, as well as stochastic periods representing breakdowns for machines can be 
defined. 

Products and services (sheets 9, 10 and 11) 
This category of information allows one to define the products or services (sheet 9) offered. 
Routings or recipes (sheet 10) and product’s contents (sheet 11) can be detailed. The routings 
also refer to the resources used to complete the specific operation of each step.  
 

Orders or work agendas (sheets 12 and 13) 
Resources, products and recipes only define “static” elements of a system. Without customers, a 
bank will not operate; without a demand, a factory cannot produce. Orders or work agendas make 
things happen in a model. Orders can be real work/stock/supply orders for a given period of time, 
with specific delivery dates or based on demand and components consumption forecasts. 
Repetitive orders can also be considered. 
 

4.2 Input data sheets 
ABC Planner has many features to help the user to build their model. First, the sheets of the Data 
Entry Zone (DEZ) contain default values in many fields. This provides a default value that the 
user will sometimes want to use and indicates to him what type of data the field expects. 
Secondly, many fields contain a drop down list that are used to enter a value when one positions 
oneself on the field. The next Figure shows such a drop down list. These drop down lists appear 
in every field for which there exists a set of predefined values that can be entered in the field. For 
example, the RULE field (seen on the next Figure) regarding Stations contains a drop down list 
displaying all the valid Rules that can be entered in the field. The user just needs to select the 
desired RULE in order to enter it into the field. 

Furthermore, ABC Planner also displays drop down lists on fields for which the possible values 
depend on data previously entered in fields of other sheets. For instance, the DEPARTMENT 
column of the Station Sheet contains a drop down list enumerating all the Departments that the 
user has previously entered in the first sheet, concerning Departments. The user just needs to 
select the desired Department in order to enter it in the field. He does not need to retype it again. 
These lists facilitate and accelerate data entry work and eliminate the risk of misspelling an entry. 
The program will not accept a name that is not in the drop down list, eliminating thus 
discrepancies. Only valid values will be able to be entered. Moreover, these lists are dynamic. If 
the user would go back for instance to the Department Sheet to add another Department, he 
would see the added Department in the drop down list when he would position himself again on 
the Department field of the Station Sheet.  
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Drop Down Menu used to enter Values 

 

Finally, ABC Planner provides a dialog box from which the user selects a date for every date 
field in the DEZ. The user only needs to click on a date field for this dialog to appear. He then 
can select the appropriate date and time (if applicable) in order to enter the value in the desired 
field. The user does not have to worry about the proper format, which will be provided 
automatically by ABC Planner. All date field must be in the format mm:dd:yyyy:hh:nn (mm = 
Month in two digits, dd = Day in two digits, yyyy = Year in four digits, hh = Hour in 24 hours 
format and nn = Minutes in two digits) except for the start and finish date of calendars which are 
in the mm:dd:yyyy format. See following Figure. 
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Dialog 
enabling user 
to enter date 

Space used to 
enter time if 
necessary 

Dialog enabling one to select a Date 

 

Column types 
Each column has a type. The different types are the following. The Contextual Help indicates 
what type of data the field expects. 

String 
- Alphanumeric characters without blanks (i.e. space, tabulation). The underscore 

character (“_”) can be used to separate names in a string (except for the LOT name in 
the Order Sheet, which cannot contain an underscore character). Most of the time there 
is no default for string fields in ABC Planner. 

Keyword 
- String chosen from a list of valid strings. ABC Planner will provide a drop down list 

containing the valid strings. 
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Integer 
- Positive or negative whole numeric value (without decimals). 

Real 
- Positive or negative whole or fractional numeric value (with or without decimals). 

Currency 
- Positive or null numeric value (with decimals). 

Date 
- Calendar date using the following format: mm:dd:yyyy:hh:nn 

Interval 
- Interval between two hours, separated by a dash: hh:mm- hh:mm 
- Example: 08:00-17:00 

Criterion (keyword) 
- Example: STEP, ELAPSEDTIME or NOLAUNCH. 
- See sheet BOM(7) for more details. 

Distribution (keyword) 
- Example: BETA, BINO, CONS, GAMM, EXPO, NORM, POIS, TRIA, UNIF, WEIB. 
- See “Choosing a distribution” for details. 

Combined fields 
- When duration, prices or variable quantities have to be represented with probabilistic 

distributions, ABC Planner will combine the information contained in 4 consecutive 
data fields: **DIST, **1, **2, **3, where **DIST columns contains the name of the 
distributions to be used, and the other fields contain the parameters of the distribution 
(1, 2 or 3 parameters depending on the distribution). 
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4.3 Data field definitions 
This section details the meanings of each column in the Data Entry Zone (DEZ). The format used 
in the section is the following: 

 

Worksheet name (index) 

• Column index: usual field name 
Meaning:  general definition. 
Type:  string, integer, real, keyword, etc. 
Example:  valid value. 
Default value:  default value if no user entry. 
Links:  other worksheets where this field is also referenced. 
Comments:  detailed explanation or warning. 

 

The two models detailed at the end of this manual illustrate further how the different data entry 
fields can be used. 
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Departments (1) 

• Column 1: department name 
Meaning:  unique name 
Type:  string 
Example:  CUSTOMER_SUPPORT 
Default value:  no default; 
Links:  stations (3), routings (10) 
Comments:  this field cannot be left empty 

• Column 2: capacity 
Meaning:  maximum number of units that can be in the department at any time 
Type:  positive integer 
Example:  3 
Default value:  9999999 
Links:  none 
Comments:  can also be interpreted as physical space available or number of seats 

• Column 3: inventory or waiting cost ($/u/h) 
Meaning:  cost for an unit waiting in the department without being served  
Type:   real number 
Example:  0.003 
Default value:  0 
Links:  none 
Comments:  this cost is reported individually 
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Storage or waiting areas (2) 
The only difference between storage areas and departments is that stations (3) can only be, and 
are always attached to departments that provide waiting space for the stations. Storage areas can 
be used to represent waiting rooms, warehouses, etc. 

This sheet need not be completed if there is no Storage or waiting areas. 

• Column 1: waiting room or warehouse name 
Meaning:  unique name 
Type:  string 
Example:  FinishedGoodsWarehouse 
Default value:  none 
Links:  routings (10) 
Comments:  no default value, the user cannot leave this field blank 

• Column 2: capacity 
Meaning:  maximum number of units in the area at any time 
Type:  positive integer 
Example:  3 
Default value:  9999999 
Links:  none 

• Column 3: storage or waiting cost ($/u/h) 
Meaning:  cost per unit 
Type:   real 
Example:  0.003 
Default value:  0 
Links:  none 
Comments:  this cost is reported individually 
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Stations (3) 

• Column 1: workplace or employee 
Meaning:  unique name of a main resource (station or operator) 
Type:   string 
Example:  Lathe1 
Default value:  none 
Links:  exception (6), downs (7) 
Comments:  no default value, the user cannot leave this field blank 

• Column 2: department 
Meaning:  see worksheet #1 - column 1 
Type:  string 
Example:  Customer_support 
Default value:  none 
Links:  departments (1), routings (10) 
Comments:  this name has to be defined in worksheet #1 

• Column 3: sequencing rule 
Meaning:  rule used by the station to sort and select the activities to be performed 
Type:  keyword (rule) 
Example:  EDD 
Default value:  FIFO 
Links:  none 
Comments:  see table below 
 
Rule Comments 
FIFO First In First Out – picks the first entity in line 
LIFO Last In First Out – picks the last entity in line 
EDD Earliest Due Date – selects the entity whose due date (worksheet 12 – column 7) is 

the closest in the future or is the more distant in the past 
ESD Earliest Start Date – selects the entity with the oldest start date (worksheet 12 – 

column 6) 
HP Highest Priority – selects the entity with the highest priority value (worksheet 12 – 

column 4) 
LP Lowest Priority – selects the entity whose priority value is the smallest 
HV Highest value – selects the entity whose current value is the highest 
LV Lowest value – selects the entity whose current value is the lowest 
SSU Same Setup – prioritizes the entity requesting the same setup (see worksheet #10 – 

column 6) as the previous entity processed at the station and uses FIFO to select in 
list of entities with same setup or the list of remaining entities if the first list is 
empty 
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Rule Comments 
SPT Shortest Processing Time – selects the entity requesting the shortest processing time. 

The processing time is defined in worksheet #10 – columns 7 to 11 
WINQ Work In Next Queue – selects the entity whose next operation’s queue is the shortest 
CR Critical Ratio – sorts the entity based on the remaining processing time versus the 

remaining time until their due date. The most urgent entity according to this ratio is 
then selected 

HRT Highest Remaining Time – selects the entity whose remaining processing time is the 
highest 

LRT Lowest Remaining Time (slack) – selects the entity whose remaining processing time 
is the lowest 

 

• Column 4: capacity 
Meaning:  maximum number of entities that can be processed simultaneously 
Type:  positive integer 
Example:  3 
Default value:  1  
Links:  none 
Comments: (please see columns 5 and 6). A lot of multiples units is considered as 

a unique entity (see order sheet) when the batch type (see column 5) is 
xlots, at the contrary to the department and storage sheets. The 
operation time can nevertheless be defined in function of the number 
of units (see route sheet), regardless of the batch type. 

• Column 5: batch type 
Meaning:  entities grouping when the capacity is greater than 1 
Type:  keyword (batch type) 
Example:  xpieces 
Default value:  xlots  
Links:  none 
 
Type Comments 
xpieces The capacity indicates the number of units that can be processed simultaneously. 

For example, with a capacity of 10 “xpieces” and an operation time (defined in 
the routing file, columns 7 to 11) of 2 min per piece, a lot of 43 units will require 
10 minutes of processing (4 groups of 10 units + 1 group of 3 units). 

Xlots The capacity indicates the number of lots (regardless of how many units they are) 
that are to be batched for an operation on this station 

Cont The capacity indicates the maximum number of lots that can be treated 
simultaneously at the station. These lots are admitted one at a time (continuous 
loading). 
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• Column 6: max. waiting time (h) 
Meaning:  maximum delay to wait before admitting a partial batch when the 

capacity is greater than 1 and the batch type is xlots 
Type:  positive real 
Example:  3 
Default value:  0  
Links:  none 

• Columns 7,8,9,10: setup time (h) 
Meaning:  time requested to (re)configure the station between two consecutive 

entities having a different setup code (worksheet 10 – column 6) 
Type:  distribution  
Example:  UNIF 3 / 2 / 0 (see section “choosing a distribution”) 
Default value:  CONS 0 / 0 / 0 (see section “choosing a distribution”) 
Links:  none 
Comments:  see section “choosing a distribution” 

• Column 11: setup cost ($/h) 
Meaning:  cost of configuring the station 
Type:  currency 
Example:  0 
Default value:  0 
Links: none 
Comments:  this value is multiplied by the setup time to determine the setup cost. 

• Column 12: % efficiency 
Meaning:  the processing time is multiplied by this factor to determine how long 

it really takes on this station to complete the operation  
Type:  positive real 
Example:  0.95   (=95%) 
Default value:  1  (=100%) 
Links: none 
Comments:  [0-1[ = underachiever; ]1-∞[ = overachiever 

• Columns 13 to 16: ShiftCal 
Meaning:        shift used by station (it is possible to attach up to 4 shifts to a station) 
Type:          string 
Example:         DayShift 
Default value:          none 
Links:          shifts(4) 
Comments:         Please see “Shifts (4)” for more details regarding these fields. 
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Shifts (4) 
Shifts are attached to stations (sheet 3). 

• Column 1: shift name 
Meaning:  unique name 
Type:   string 
Example:  DayShift 
Default value:  none 
Links:   station(3) 
Comments:  no default value, the user cannot leave this field blank 

• Column 2: off cost ($/h) 
Meaning:  Hourly cost associated with the off duration 
Type:   Real 
Example:  0.5 
Default value:  0 
Links:   none 

• Column 3: start date 
Meaning:  Date when the calendar is to be started 

The calendar start date has to be prior of at least one month to the 
simulation start date 

Type:   Date in the format mm:dd:yyyy 
Example:  01:01:2002 
Default value:  none 
Links:   none 
Comments: The start date must correspond to the day of the week on which the 

calendar is due to start. If for example the calendar starts on a Monday and 
repeats itself five days out of seven (from Monday to Friday) during every 
cycle (see columns 5 and 6), the day of the starting date must be a Monday 
(previous of at least one month to the simulation start date). 

• Column 4: end date 
Meaning:  Date when calendar is to be stopped 
Type:   Date in the format mm:dd:yyyy 
Example:  12:31:2002 
Default value:  none 
Links:   none 
Comments: Date must be greater than the start date 

The simulation can actually end before the calendar’s end date. (The 
simulation’s end date can be prior to the calendar’s end date.) 
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• Column 5: cycle (days) 
Meaning: Number of days in this shift 
Type:    Positive integer 
Example:   1 
Default value:   7 
Links:    none 
 

• Column 6: repeat (days) 
Meaning: Number of consecutive days which the shift is repeated in the cycle 
Type:  Positive integer 
Example:  1 
Default value:  5 
Links:  none 
Comments:  Must be less than Cycle 
 

Important note concerning Calendars: 
For every shift that has a number of repeat (column 6) which is less than the number of days in 
the cycle of column five (5 days out of 7 for example) the user must define a second shift 
indicating the number of days during which the station is not available (2 days out of 7 in our 
example). If the user does not define this second shift, the station will be available during the 
days not covered by the repeat period (2 days out of 7 in our example). The user will indicate 
ABC Planner that the station to which the calendar is attached is down (not available) during the 
period in question, by defining a second shift and indicating 00:00-00:00 as the ON period 
(leaving all the fields blank) for all the ON fields. Be careful to indicate a start date, which 
corresponds to the desired day. If the working calendar is from Monday to Friday for example, 
and the station is down during the weekend (Saturday and Sunday), the user will have to indicate 
a starting date for the second calendar that starts on a Saturday. This calendar will have a cycle 
(column 5) of 7 days and a repeat value of 2 days in column 6. The station will then be down 
(00:00-00:00) during 2 days out of 7. Be sure to attach the two shifts to the stations to which they 
apply. 

• Column 7 to 14: On time 
Meaning:   Time periods when the shift is operating 
Type:    Interval 
Example:   07:30-12:45 
Default value:   none 
Links:    none 
Comments:   Use only as many as needed. Leave the rest blank. 
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Note regarding ON Fields: 
The user must use the eight fields in order (ON1 to ON 8). If he skips a field ABC Planner will 
assume that there is no more data in the next fields. If the first field contains the shift 00:00-
00:00, the station to which the calendar is attached will be off during the shift. ABC Planner will 
consider the interval between two time frames as down time. If for example, the user defines a 
shift that has the two following time frames 09:00-12:00 and 13:00-17:00, then ABC Planner will 
interpret that there is a “break” between 12:00 and 13:00 hours. Similarly, the stations to which 
the calendar is attached will be down from midnight to 9:00 and from 17:00 to midnight the next 
day. The stations will be on from 9 to 12 and from 13 to 17 hours. 
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Holidays (5) 
Use this sheet to specify a list of Holidays. When multiple calendars are attached to a resource, 
the OFF state prevails over the ON state. 

This sheet need not be completed if there is no holiday. 

• Column 1: holiday name 
Meaning:   Name of the holiday or off period 
Type:    String (unique value) 
Example:   Christmas_2002 
Default value:   none 
Links:    none 
Comments:   no default value, the user cannot leave this field blank 

• Column 2: department 
Meaning:   department that this holiday applies to 
Type:    String 
Example:   Customer_Support 
Default value:   ALL 
Links:    dept (1) 
Comments:   Select ALL to apply to all departments. 

• Column 3: off cost ($/h) 
Meaning:   Hourly cost associated with the duration of the off period. 
Type:    Real 
Example:   0.5 
Default value:   0 
Links:    none 

• Column 4: start date 
Meaning:   Date when the calendar is to be started 
Type:    Date with mm:dd:yyyy:hh:nn format 
Example:   12:25:2002:00:00 
Default value:   none 
Links:    none 

• Column 5: end date 
Meaning:   Date when calendar is to be stopped 
Type:    Date with mm:dd:yyyy:hh:nn format 
Example:   12:26:2002:00:00 
Default value:   none 
Links:    none 
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Comments:  Date must be greater than start date 

 

Exceptions (6) 
Use this sheet to specify a list of Exceptions. When multiple calendars are attached to a resource, 
the OFF state prevails over the ON state. 

This sheet need not be completed if there is no exception. 

• Column 1: exception name 
Meaning:   Name of the exception or off period 
Type:    String (unique value) 
Example:   Charlie_Dentist 
Default value:   none 
Links:    none 
Comments:   no default value, the user cannot leave this field blank 

• Column 2: station 
Meaning:   station that this exception applies to 
Type:    String 
Example:   Saw1 
Default value:   none 
Links:    stn (3) 

• Column 3: off cost ($/h) 
Meaning:   Hourly cost associated with the duration of the off period. 
Type:    Real 
Example:   0.5 
Default value:   0 
Links:    none 

• Column 4: start date 
Meaning:   Date when the calendar is to be started 
Type:    Date with mm:dd:yyyy:hh:nn format 
Example:   07:01:2002:08:00 
Default value:   none 
Links:    none 

• Column 5: end date 
Meaning:   Date when calendar is to be stopped 
Type:    Date with mm:dd:yyyy:hh:nn format 
Example:   07:01:2002:10:00 
Default value:   none 
Links:    none 
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Comments:  Date must be greater than start date 

 

Downs (7) 
Use this sheet to specify a list of Downs. Typically used to define a preventive maintenance or a 
breakdown period. When multiple calendars are attached to a resource, the OFF state prevails 
over the ON state. 

This sheet need not be completed if there is no down. 

• Column 1: calendar name 
Meaning:  unique name 
Type:   string 
Example:  break1 
Default value:  none 
Links:  none 
Comments:  no default value, the user cannot leave this field blank 

• Column 2: station or employee 
Meaning:  see worksheet #3 – column 1 
Type:   string 
Example:  Lathe1 
Default value:  none 
Links:  stations (3) 
Comments:  no default value, the user cannot leave this field blank 

• Columns 3,4,5,6: ON period (h) 
Meaning:  duration of the period when the station is available 
Type:  distribution 
Example:  BETA / 2 / 0.8 / 720 (see section “choosing a distribution”) 
Default value:  CONS / 0 / 0 / 0 (see section “choosing a distribution”) 
Links:  none 
Comments:  see section “choosing a distribution” 

• Columns 7,8,9,10: OFF period (h) 
Meaning:  duration of the period where the station is not available 
Type:  distribution 
Example: CONS / 10 / 0 / 0 (see section “choosing a distribution”) 
Default value: CONS / 0 / 0 / 0 (see section “choosing a distribution”) 
Links:  none 
Comments:  see section “choosing a distribution” 

• Column 11: repair cost ($/h) (optional) 
Meaning:  optional hourly cost associated with the OFF duration 
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Type:  real 
Example:  0.5 
Default value:  0 
Links:  none 

• Column 12: start date 
Meaning:   Date when the calendar is to be started 
Type:    Date with mm:dd:yyyy:hh:nn format 
Example:   07:01:2002:08:00 
Default value:   none 
Links:    none 

• Column 13: end date 
Meaning:   Date when calendar is to be stopped 
Type:    Date with mm:dd:yyyy:hh:nn format 
Example:   07:01:2002:10:00 
Default value:   none 
Links:    none 
Comments:  Date must be greater than start date 
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Tool – Auxiliary Resources (8) 
This sheet need not be completed if there is no auxiliary resource. 

• Column 1: tool, vehicle or employee name 
Meaning:  unique name of the resource 
Type:   string 
Example:  Oper_Stn1 
Default value:  none 
Links:  routings (10) 
Comments:  identifies a resource needed at a certain step or for certain activity in 

the production process and available in limited quantity. 

• Column 2: quantity 
Meaning:  number of resources available 
Type:   integer 
Example:  3 
Default value:  1 
Links:  none 
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Part (9) 

• Column 1: product or service name 
Meaning:  name of a product reference, a category of services or a type of activity 
Type:  string 
Example:  10345_WC34 
Default value:  none 
Links:  routings (10), BOM (11), orders (12), supplies (13) 
Comments:  no default value; the user must provide a unique name for this field; 

used to identify a category of products or services that uses the 
resources of the system by following a detailed list of activities 
indicated in the route sheet. 

• Column 2,3,4,5: raw material cost ($/u) 
Meaning:  this cost will also be used as the initial value of an item of this product 

family when it enters the system. 
Type:  distribution 
Example:  CONS / 3.4 / 0 / 0 (see section “choosing a distribution”) 
Default value:  CONS / 0 / 0 / 0 (see section “choosing a distribution”) 
Links:  none 
Comments:  see section “choosing a distribution” 

• Column 6: final value ($/u) 
Meaning:  default final value of an item of this product type. It can be overwritten 

by an order specific value (see worksheet 12 – column 8) 
Type:  real 
Example:  95.99 
Default value:  0 
Links:  none 

• Column 7: initial inventory 
Meaning:  quantity available at the beginning of the simulation 
Type:  integer 
Example:  3 
Default value:  0 
Links:  none 
Comments:   this field is used only for products to be consumed in an assembly 

operation. It can also be used in a make-to-stock environment. 
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Route (10) 
The combination of column 1 and column 2 has to be unique. 

• Column 1: step ID 
Meaning:  identifier for a step 
Type:  string 
Example:  10A 
Default value:  none 
Links:  BOM (11) 
Comments:  no default value; the user must provide a value for this field; for 

readability, the steps for a given product should be listed sequentially 
in ascending order (without any interruption for any given product).  

• Column 2: product or service 
Meaning:  see worksheet #9 – column 1 
Type:  string 
Example:  10345_WC34 
Default value:  none 
Links:  part (9), BOM (11), order (12), supply (13) 
Comments:  no default value; the user must provide a valid name for this field  

• Column 3: department/storage 
Meaning:  see worksheet #1 or #2 – column 1 
Type:  string 
Example:  Registration 
Default value:  none 
Links:  departments (1), storage (2) 
Comments:  no default value; the user must provide a valid name for this field ; the 

department or the storage unit must have been identified previously. 

• Column 4: tool (auxiliary resources)  
Meaning:  optional, see worksheet #8 – column 1 
Type:  string 
Example:  Furnace_operator 
Default value:  0, meaning that there is no auxiliary resource used at the step 
Links:  tool (8) 
Comments: must have been previously identified in the tool sheet. 
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• Column 5: amount of resources 
Meaning:  number of auxiliary resource(s) requested for the step: positive integer 

when there is an auxiliary resource attached to the step, 0 otherwise 
Type:  integer 
Example:  10 
Default value:  0 when no auxiliary resource is attached to the step 
Links:  none 

• Column 6: setup type (optional) 
Meaning:  setup code for the step. Used to decide when the setup time should be 

taken and for the SSU sequencing rule. 
Type:  string 
Example:  SET56 
Default value:  0 
Links:  none 
Comments:  can be dependant of the product, tooling, material etc. 

• Columns 7,8,9,10: step throughput 
Meaning:  indicates the production rate in items/time or time/items depending on 

the contents of column 11 
Type:  distribution 
Example:  UNIF / 25 / 1 / 0  (see section “choosing a distribution”) 
Default value:  CONS / 0 / 0 / 0 (see section “choosing a distribution”) 
Links:  none 
Comments:  see section “choosing a distribution” 

• Column 11: unit 
Meaning:  unit for the step throughput 
Type:  keyword 
Example:  hpp 
Default value:  lph 
Links:  none 
Comments:  can take a value from the following list: 

 

Unit Definition Comments 
hpl Hour Per Lot  see worksheet 3 (column 5) for the distinction between lot 

and piece 
hpp  Hour Per Piece   
lph Lot Per Hour   
pph Pieces per hour  
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• Column 12: operation cost ($/h) (optional) 
Meaning:  optional hourly cost for performing this operation 
Type:  currency 
Example:  0.34 
Default value:  0 
Links:  none 

• Column 13: value added ($/u) (optional) 
Meaning:  optional value added to the entity for this step.  
Type:  currency 
Example:  0.45 
Default value:  0 
Links:  none 
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BOM (11) 
BOM stands for Bill Of Material, it is a mean to detail the components required to build a 
product (quantities and step). It can be seen as a list of ingredients for a recipe. 

This sheet need not be completed if there is no BOM. 

• Column 1: component name 
Meaning:  see worksheet #9 – column 1 
Type:  string 
Example:  BF_345_T1 
Default value:  none 
Links:  part (9), route (10), order (12), supply (13) 
Comments:  no default value; the user must provide a valid name for this field; the 

name has to be identified in the part (9) sheet (first column). 

• Column 2: assembly name 
Meaning:  see worksheet #9 – column 1 
Type:  string 
Example:  BF_345 
Default value:  none 
Links:  part (9), route (10), order (12), supply (13) 
Comments:  no default value; the user must provide a valid name for this field; the 

name has to be identified in the part (9) sheet (first column). 

• Column 3: components quantity 
Meaning: number of components required per unit of assembly 
Type:  integer 
Example:  3 
Default value:  1 
Links:  none 

• Column 4: step 
Meaning: step in the assembly routing where the component is consumed 
Type:  string 
Example:  ETAPE_18 
Default value:  none 
Links:  route (10) 
Comments:  no default value; the user must provide a valid name for this field; 

must be identified in the route sheet (10) (first column). 
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• Column 5: launch criteria for the components 
Meaning: details how the components should be supplied for the assembly. ABC 

Planner supports the automatic launch of components (lot-for-lot 
method). The assembly lot can launch the components. See the 
following table for the possible values in this field. 

Type:  keyword 
Example:  STEP 
Default value:  NOLAUNCH 
Links:  none 
Comment: the component, which launch criterion is “STEP” or “ELAPSED 

TIME”, must have a route of at least one step. 
 
 

Criterion Comments 
ELAPSEDTIME Fixed delay between the start of the first operation for 

the assembly and the component start time (in hours) 
STEP Step of the assembly routing at which the component 

should be launched (“golf ball” concept) 
NOLAUNCH The assembly does not launch an order for the 

components. The user is responsible for specifying the 
initial inventory, scheduled supplies or make-to-stock 
orders for the component. 

 

• Column 6: launch parameter 
Meaning: parameter used with the launch criterion 
Type:  positive real for ELAPSEDTIME 
 string for STEP 
 0 for NOLAUNCH 
Example:  0  
Default value:  0, associated with the NOLAUNCH criterion 
Links:  none 
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Order (12) 
Note: An order or lot can be a patient or a customer; it’s an entity of a given product type 
(worksheet 9). A lot can be composed of more than 1 item or piece (e.g. an order for 10 pizzas in 
a restaurant). 

• Column 1: lot name 
Meaning:  unique name for the lot, task, person, etc. 
Type:  string 
Example:  OrderNum2357 
Default value:  none 
Links:  none 
Comments:  no default value; the user must provide a value for this field  

• Column 2: product type (Part) 
Meaning:  see worksheet 9 – column 1 
Type:  string 
Example:  10345_WC34 
Default value:  none 
Links:  part (9), route (10), BOM (11), supply (13) 

• Column 3: quantity (Num Pieces) 
Meaning:  number of units of the product in this lot 
Type:  positive integer 
Example:  12 
Default value:  1 
Links:  none 

• Column 4: priority 
Meaning:  optional; used in the rules LP or HP 
Type:  integer 
Example:  1 
Default value:  0 
Links:  none 

• Column 5: category (Lot type) 
Meaning:  type of order 
Type:  keyword 
Example:  S 
Default value:  O 
Links:  none 
Comments:  O = customer order, S = stock order. Stock orders are stored once 

completed. Customer orders are shipped immediately upon 
completion. 
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• Column 6: start date 
Meaning:  launch date. Nothing will be attempted on the lot until this date is 

reached 
Type:  date with format mm:dd:yyyy:hh:nn 
Example:  12:21:2002:10:00 
Default value:  01:01:2002:08:00 
Links:  none 
Comments:  used also by the ESD rule (see worksheet #3 – column 3). 

• Column 7: due date 
Meaning:  date the lot should be completed; this is a target, not a constraint 
Type:  date with format mm:dd:yyyy:hh:nn 
Example:  12:23:2002:15:00 
Default value:  01:01:2002:08:00 
Links:  none 
Comments:  used also by the EDD rule (see worksheet #3 – column 3). 

• Column 8: price ($/u) (Sales Value) 
Meaning:  sales value; overwrites the product’s sales value (see worksheet 9) 
Type:  real 
Example:  56.0 
Default value:  0 
Links:  none 

• Column 9,10,11,12: repeat frequency (h) 
Meaning:  Fixed or stochastic repeat rate for the lot (interval between two 

repetitions). Second and subsequent lots will have the name appearing 
in column 1 plus their ordinal index appended at the end. 

Type:   distribution 
Example:  NORM / 100 / 12 / 0  (see section “choosing a distribution”)  
Default value:  CONS / 0 / 0 / 0 (see section “choosing a distribution”) 
Links:  none 
Comments:  see section “choosing a distribution” 

• Column 13: amount of repetitions 
Meaning:  number of repetitions when repeated 
Type:  integer 
Example:  1 
Default value:  0 
Links:  none 
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Supply (13) 
This sheet need not be completed if there is no Supply order. 

• Column 1: order 
Meaning:  unique order reference 
Type:  string 
Example:  P3456 
Default value:  none 
Links:  none 
Comments:  no default value; the user must provide a value for this field  

• Column 2: product 
Meaning:  see worksheet 9 – column 1 
Type:  string 
Example:  10345_WC34 
Default value:  none 
Links:  part (9), route (10), BOM (11), order (12) 

• Column 3: quantity ordered 
Meaning:  quantity ordered 
Type:  positive integer 
Example:  12 
Default value:  1 
Links:  none 

• Column 4: scheduled reception date 
Meaning:  date at which the units will be considered as available for processing 
Type:  date with format mm:dd:yyyy:hh:nn 
Example:   12:21:2002:08:30 
Default value:  none 
Links:  none 

• Column 5: order cost ($/u) 
Meaning:  ordering cost per unit 
Type:  currency 
Example:  12.5 
Default value:  0 
Links:  none 
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• Column 6,7,8,9: repeat frequency (h) 
Meaning:  allows periodic reception of supplies 
Type:  distribution 
Example:  CONS / 10 / 0 / 0 (see section “choosing a distribution”) 
Default value:  CONS / 0 / 0 / 0 (see section “choosing a distribution”) 
Links:  none 
Comments:  see section “choosing a distribution” 

• Column 10: amount of repetitions 
Meaning:  number of supply order repetitions 
Type:  integer 
Example:  1 
Default value:  0 
Links:  none 
Comment: When the last repetition is accomplished, the order is deactivated. 
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System Information (14) 

• Column 1: model name 
Meaning:  Name as it was spelled when the model was created. This value is 

added automatically at creation. The name cannot be modified. 
Type:  string without space or special characters 
Example:  ABCModel 
Default value:  chosen name 
Links:  none 
Comments: The user must not change the model name. 

• Column 2: indirect costs ($/h) 
Meaning:  Total indirect costs associated with the use of the system (calculated 

per hour) 
Type:   real 
Example:  2.45 
Default value:  0 
Links:  none 
Comments:  calculated per hour simulated 
 

Comments (15) 

• Column 1: Comments 
Meaning:  The user can use this field to enter comments regarding the model. 
Type:  any alphanumeric character 
Example:  Master Scheduling Model… 
Default value:  none 
Links:  none 
Comments:  This sheet is not used by the simulation engine. 
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Scenarios/WIP Sheets 
 
The WIP Sheet can be accessed by pressing the Scenarios/WIP Button of the Floating Menu 
(following figure) or through the View Menu. The WIP Sheet contains all the information 
regarding the Work In Process of the production system. The user can either use the real WIP, 
which needs to be entered on a daily bases (or imported from an ERP or a Shop Floor system) or 
use the simulated WIP. The simulated WIP is the WIP, which theoretically exists in the 
production system, based on the last simulation. The real WIP is created by saving the data 
entered in the WIP Sheet for later usage. The user must press the Confirm Actual WIP Button on 
the Floating Menu to save the entered WIP. To import the WIP (Simulated or Real), the user 
presses the Import Orders, Parts & WIP Button. The software will then ask the user if he “Would 
like to import the Actual WIP?” If the user accepts, the Real WIP will be imported into the WIP 
Sheet. If the user refuses, the simulated WIP will be imported. The user can then eventually make 
adjustments and save the WIP for future usage.  
 
The following information needs to be provided to the system in order to use the WIP. 
 
The Lot for which there is WIP must be entered in the first column. The Lot must exist in the 
main Orders Sheet. The Part corresponding to the Lot must be indicated. The user must indicate 
the Current Step (CURSTEP), the Current Department (CURDEPT) and the Current station 
(CURSTN) at which the Part is. If the Part is in a Department but not being processed, the value 
0 must be entered. The user finally indicates the completion percentage of the Part at the 
corresponding Step. During a future Simulation using the WIP, the system will deduct the time 
for process at the appropriate step, corresponding to the completion percentage. 
 
The Import Orders, Parts & WIP Button of the Floating Menu also imports the Orders and the 
Parts existing in the Main Orders and Parts Sheets into the Scenarios Orders and Parts Sheets. 
The user can use these sheets for what-if analysis, by adding new Orders and Parts without 
affecting the Main Orders and Parts Sheets. He can nevertheless export these new Scenario 
Orders and Parts into the Main Sheets if he whishes, by pressing the Confirm Orders and Parts 
Button. 
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Confirm Orders 
& Parts 

Confirm Actual 
WIP 

Import Orders, Parts 
& WIP 

 
Scenarios WIP Sheet 
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CHAPTER 5: RUNNING A SIMULATION 
When the user launches a simulation, the software displays the dialog shown below into which 
the user must enter information regarding simulation parameters. Before launching the 
Simulation, the user must select the type of Simulation he wishes to execute: Planning or 
Scenario. The Planning alternative should be used for the operational Scheduling of activities, 
while the Scenario Simulation may be used for what-if analysis. When one selects the Scenario 
alternative, the Planning results of any previous Simulation are not overwritten by the Scenario 
execution. The user can thus proceed to multiple what-if analysis without overwriting the 
Planning scheduled. Furthermore, the user must indicate to the Simulator, if the WIP should be 
used or not for the Simulation. 

 

 

WIP 
Components 

Type of 
Simulation 

 
Simulation Parameters Window 

 
ABC Planner asks the user to provide it the following information: 

1) Start Date of simulation; 
2) Length of simulation, indicated either in days, hours, minutes or seconds; 
3) Simulation end date will be calculated automatically by software based on start date and 

length of simulation; 
4) The report frequency (in hours) is used to generate periodic snapshot of the inventory per 

product (partinv.gph) and per department (deptinv.gph) as well as the station utilization 
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(stnutil.gph). Value 0 means that no report will be produced. The snapshots are used for 
calculating aggregate data. 

5) The random stream ID is used to pick a starting value in the random stream and leads to 
different simulation results between simulation runs when changed, when probabilistic 
distributions are used in the model. The user can enter any integer value between 0 and 99 
(i.e. up to 100 different runs can be made with same data and other parameters 
unchanged). 

 
When a simulation is launched, the model is validated. If an error occurs during the validation 
process, the simulation is interrupted. If no error is encountered, the simulation starts. To end the 
simulation before it completes, one can select the Stop Execution Sub Menu from the Run Menu. 
Meanwhile, this will only indicate ABC Planner to stop waiting for the end of the simulation, but 
does not stop the simulation process. To stop the simulation engine, one must cancel the amrun 
process through the Task Manager (accessed by simultaneously holding the Ctrl – Alt – Delete 
keys). 

Once the simulation is completed, ABC Planner imports the report files that were generated 
during the simulation. 
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CHAPTER 6: REPORTS 

6.1 Data Reports 
There are 19 spreadsheet-like data reports in ABC Planner, which provide statistics regarding 
performance of the different components of the system and inventory and resource utilization. 
There is also a report that lists all the actions that have occurred during the simulation. 

The information contained in the spreadsheet-like data reports give a global representation of the 
system and the activities that have been accomplished between the start and the end of the 
simulation. The information is compiled during the simulation. The reports integrate 
supplementary information regarding the simulation every time that a “notable” event occurs, like 
the exit of a lot of the system or the end of a production step for instance. These summary reports 
contain information on quantities, duration and minimum, maximum and average actual costs. 

 

dept - dept wip Information regarding WIP for department 

dept - stock/dept Information regarding stocks per department 

dept - eff/dept  Information regarding efficiency per department 

stn - stn wip  Information regarding WIP for stations 

stn - eff/stn  Information regarding efficiency per station 

part - part wip  Information regarding WIP for parts 

part - stock/part Information regarding stocks per part 

part - eff/part  Information regarding efficiency per part 

lot - lot   Information regarding lots 

lot - eff/lot  Information regarding efficiency per lots 

seq   Information regarding production sequence 

step   Information regarding production steps 

tool   Information regarding tools 

syst - syst wip  Information regarding WIP for the production system 

syst - syst stock Information regarding stocks for the production system 

syst - syst eff  Information regarding efficiency for the production system 
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The following tables contain the definition of each field of data: 

 
Column Report Category Comments 

%UTIL stn Percentage of use (average load / capacity) 
%DOWN stn Percentage of time spent in mode unavailable 
%IDLE stn Percentage of time spent in mode available 
%PROC dept, lot, part, 

stn, step, syst 
Percentage of time spent in mode processing (from the lot 
perspective and regardless of the station capacity) 

%SETUP dept, lot, part, 
stn, step, syst 

Percentage of time spent in mode setup 

%WAITDOWNSTN dept, lot, part, 
step, syst 

Percentage of time spent in mode wait for down station (the 
operation is started, but the station becomes unavailable) 

%WAITFORSTN dept, lot, part, 
step, syst 

Percentage of time spent in mode wait for station (the operation is 
not started yet and the lot waits for a station to be free) 

%WAITINDEPT dept, lot, part, 
step, syst 

Percentage of time spent in mode wait for next department (the 
operation is completed and the lot waits for entering the next dept) 

AVGCOST dept, part, stn, 
step, syst 

Average cost by lot produced 

AVGEARLINESS part, syst Average lot completion earliness (hours) 
AVGLATENESS part, syst Average lot completion tardiness (hours) 
AVGPROC*** dept, part, stn, 

step, syst 
*** = COST, TIME  average processing time and cost per lot 

AVGSETUP*** dept, part, stn, 
step, syst 

*** = COST, TIME average setup time and cost per lot 

AVGVALUEADDED dept, part, stn, 
syst 

Average value added per lot 

AVGWAITDOWNSTN*** dept, part, step, 
syst 

*** = COST, TIME average waiting for down station time and cost 
per lot 

AVGWAITFORSTN*** dept, part, step, 
syst 

*** = COST, TIME average waiting for station time and cost per 
lot 

AVGWAITINDEPT*** dept, part, step, 
syst 

*** = COST, TIME average waiting for next department time and 
cost per lot 

CAPACITY dept, stn Storage capacity 
COST dept, lot, part, 

stn, step, syst 
total production cost 

DEPT dept, step Department or storage name 
DOWNTIME Stn total down time (hours) 
IDLETIME Stn total idle time (hours) 
INDIRECTCOST Syst total indirect cost for the period of the simulation 
INVVAL*** dept, part, syst *** = CUR, AVG, MAX current, average and maximal value of the 

work in process 
LOTDONE dept, part, stn, 

step, syst, tool 
Number of lots completed 

LOTSTART dept, part, stn, 
step, syst, tool 

Number of lots started 

NUMEARLY part, syst Number of lots completed early 
NUMLATE part, syst Number of lots completed late 
NUMRES Tool Number of auxiliary resources 
PART part, lot, step Product or service name 
PROCCOST dept, lot, part, 

stn, step, syst 
total processing cost 
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Column Report Category Comments 
PROCTIME lot, stn total processing time (hours) 
REPAIRCOST Stn total repair cost 
SETUPCOST dept, lot, part, 

stn, step, syst 
total setup cost 

#SETUP Stn Number of setups performed 
SETUPTIME lot, stn total setup time (hours) 
STEP Step step name 
STN Stn station name 
STOCKINIT dept, part, syst initial inventory on-hand 
STOCK*** dept, part, syst *** = CUR, AVG, MAX current, average and maximal inventory 

quantity (finished goods, components, raw material) 
STOCKCOST dept, part, syst total stock cost 
STOCKVALUE*** dept, part, syst *** = CUR, AVG, MAX current average and maximal inventory 

value 
STOCKPCSADDED dept, part, syst Quantity added to stock 
STOCKPCSREMOVED dept, part, syst Quantity removed from stock 
SUPPLYCOST part, syst raw material and supply cost 
SYSTEM Syst model name 
TIMEBEFORESYST Lot Waiting time before initial admission in the system (hours) 
TIMINDEPT*** Dept *** = AVG, MIN, MAX average, minimal and maximal time in a 

department (hours) 
TIMINSTEP*** Step *** = AVG, MIN, MAX average, minimal and maximal time to 

accomplish a step (hours) 
TIMEINSTOCKAVG dept, part, syst Average time in stock per unit (hours) 
TIMINSYST Lot time in system per lot (hours) 
TIMINSYST*** part, syst *** = AVG, MIN, MAX average, minimal and maximal time in 

system per lot (hours) 
RESOURCE Tool Auxiliary resource name 
VALUEADDED dept, lot, part, 

stn, step, syst 
total value added 

WAITDOWNSTNCOST dept, lot, part, 
step, syst 

total down station cost 

WAITDOWNSTNTIME Lot total wait for down station time (hours) 
WAITFORSTNCOST dept, lot, part, 

step, syst 
total wait for station cost 

WAITFORSTNTIME Lot total wait for station time (hours) 
WAITINDEPTCOST dept, lot, part, 

step, syst 
total wait for next department cost 

WAITINDEPTTIME Lot total wait for next department time (hours) 
WIPLOT*** dept, part, stn, 

step, syst, tool 
*** = CUR, AVG, MAX current, average and maximal inventory 
(measured in lots, regardless of their number of units) 

WIPLOTDEPT*** Stn *** = CUR, AVG, MAX current, average and maximal inventory 
in the station’s department (measured in lots, regardless of their 
number of units) 

WIPPCS*** dept, part, step, 
syst 

*** = CUR, AVG, MAX current, average and maximal inventory 
(measured in pieces) 

 
Note: if some activities are in progress when the simulation completes and the final reports are 

printed, these activities will not be accounted in the time, cost and quantity statistics 
except for the ***CUR and ***START quantity statistics. 
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Column Report Comments 

COMPDATE lot completion date 
COMPLETED lot flag: “Y” if the lot is completed, “N” if WIP 
CURDEPT lot current department if WIP 
CURSTEP lot current step if WIP 
CURSTN lot current station if being processed 
DEPT seq step’s department (I/O) 
DUEDATE lot target due date 
ENDDATE seq step’s completion date 
LOT lot, seq lot’s name (I/O) 
NUMPIECES lot, seq lot size (I/O) 
PART lot, seq product type (I/O) 
PROC seq total processing time for the step in hours 
SETUP seq total setup time for the step in hours 
STARTDATE Lot lot’s simulation start date 
STEP seq step ID (I/O) 
STN seq station where the operation has been done 
WAITFORDOWNSTN seq total waiting for down station time in hours 
WAITFORSTN seq total waiting for station time in hours 
WAITINDEPT seq total waiting for next department time in hours 

 
Column Report Comments 

CAPACITY stnutil, deptinv Capacity (# of lots) (I/O) 
CURUTIL Stnutil current utilization (# of lots) 
CURWIPCOST Deptinv current inventory cost 
CURWIPLOT Deptinv current inventory (# of lots) 
CURWIPPCS Deptinv current inventory (# units) 
CURWIPVAL Deptinv current inventory value 
DEPT Deptinv department (I/O) 
STN Stnutil station (I/O) 
TIME stnutil, deptinv observation time (absolute value in seconds) 
VALADDED Stnutil total value added to date 
 

6.2 Reports, Histograms and Charts 
Many of the data contained in the spreadsheet-like report can be visualized with the help of 
reports, histograms and charts. There are 5 entities for which one can obtain these types of report: 
Departments; Stations; Parts; Lots and Steps. The user accesses the reports by selecting the 
Reports Button of the Floating Menu as indicated in the figure here after. 
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Once the user has selected the appropriate entity, he then must select the desired report displayed 
in the list of existing reports from the Reports drop-down Menu situated at the right of the Entity 
drop-down Menu on the Floating Menu. The list of existing reports changes based on the selected 
Entity. 

 

The existing reports for each Entity are the following: 

 
Entity Report 

Departments Department WIP Report 

Departments Department Stock Report 

Departments Department Efficiency Report 

Departments Department Cost Report 

Departments Department Utilization Chart 

Reports Icon Entity Drop-
Down Menu 

Existing Reports 
Regarding Selected 

Entity 
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Departments Department Stock Chart 

Departments Department Cost Histogram 

Departments Department WIP Chart 

Stations Station WIP Report 

Stations Station Efficiency Report 

Stations Station Cost Report 

Stations Station Utilization Chart 

Parts Parts WIP Report 

Parts Parts Stock Report 

Parts Parts Efficiency Report 

Parts Parts Cost Report 

Lots Lots WIP Report 

Lots Lots Efficiency Report 

Lots Lots Cost Report 

Steps Steps WIP Report 

Steps Steps Efficiency Report 

Steps Steps Cost Report 

Steps Dispatch List 

 

The following 4 figures display examples of Reports: 
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Station Utilization Chart 

 
WIP Pieces by Department 
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Department Efficiency Cost report 

 
Dispatch List 

 

The Dispatch List contains the Start Date (by date and time) and End Date of each produced Part 
for every Station of the system. It is possible to distribute this report to all operators of a 
production system, in order for them to follow the sequence of production. By respecting the 
indicated sequence, operators contribute to the respect of the production schedule. 

 

6.3 Frequency of Reports for Aggregated Statistics 
The frequency at which the aggregated statistics are compiled is defined by the user with the help 
of the dialog box into which the parameters of the simulation are entered. The aggregated 
statistics enable the user to have a trace (at every time unit that he chooses) of the evolution of the 
stocks and of the utilization of the stations. 

 

6.4 Gantt Charts 
It is possible to visualize all the simulated activities of the system with Gantt Charts by using 
Gantt It, which is thoroughly integrated to ABC Planner. The user can launch Gantt It directly 
from ABC Planner by pressing the Gantt It Button of the Floating Menu. By pressing this Button, 
ABC Planner will display a dialog box into which the user will be asked to enter certain 
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parameters, enabling Gantt It to display the data in the desired format. Please refer to the Gantt It 
documentation for further information on Gantt It. The following figures display the Gantt It 
dialog box launched by ABC Planner and an example of Gantt Charts created by Gantt It. 

 

 
Dialog Box launched by ABC Planner 
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Gantt Charts created by Gantt It 
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CHAPTER 7: CHOOSING A DISTRIBUTION 
 

There are several fields related to the use of distributions in ABC Planner. The first column 
contains a keyword establishing the distribution type (BETA, BINO, CONS, GAMM, EXPO, 
NORM, POIS, TRIA, UNIF, WEIB). The last three fields are used to enter the parameters of the 
distribution. Depending on the distribution type, 1, 2 or 3 parameters are necessary. 

When some parameters are not required for a distribution, the related fields should be left to 0. 

The default distribution is the CONS distribution, which necessitates only one parameter. 

The following table describes the distributions defined in ABC Planner.  

 
Distribution Example Parameters Description 
GAMM – Gamma 

 

 

A,B 
 

A >0 
B is the scale, B >0 
Domain: [0, ∝) 
Mean: AB 
Peek:   A-1 

CONS – Constant  C Constant value, C 
EXPO – Exponential 

 

M Mean:  M 
63% of values < M, 14% > 2M,  
5% > 3M, 2% > 4M  
Domain: [0, ∝) 
Peek: 0 
 

NORM – Normal 

 

M,S Mean: M  
Standard deviation: S >0 
68,7% of values between  
M-S and M+S 
95.5% of values between   
M-2S and M+2S 
Peek:  M 
Domain:  (-∝, ∝) 

TRIA – Triangular 

 

L,D,U Minimum (L), peek (D),  
maximum (U) 
Domain: [L, U] 
Peek: D  
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Distribution Example Parameters Description 
BETA – Beta 
 

 

 

 

α1 , α2, b α1, α2, b positive real values 
mean:  b (α1 /  α1 + α2)  
domain: [0,b]  
The following approximations are of 
interest for determining the peeks P: 
       α1=(M) (2P – b)/(P-M)(b) 
       α2=α1 (b-M) / M  
  

BINO – Binomial 

 

 

t, p t positive integer 
p, real, 0 < p < 1 
Domain: {0,1,…,t} 

UNIF – Uniform 

 

M, h Mean (M), deviation (h) 
Domain: [M-h, M+h] 
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Distribution Example Parameters Description 
POIS – Poisson 

 

 

λ Mean λ > 0 
Peeks λ-1and λ, or the integer part of 
λ if λ is not an integer 
Domain: {0,1,…} 
 

WEIB – Weibull 

 

α, β Alpha (shape) > 0, beta (scale) >0 
Mean: β/α  Γ(1/α) 
Peek: β (α-1/α) 1/α   (if α<1,  0) 
Domain: [0,∝) 
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CHAPTER 8: EXAMPLES 

8.1 Machining and assembly workshop 

Situation 
Fiat Lux Inc. manufactures industrial lighting equipment. There are 12 different departments in 
the facility and 18 work centers as detailed below :  

- Saw (2 work centers – saw1 and 
saw2) 

- Press (2 work centers – press1 and 
press2) 

- Drill (1 work center – drill1) 
- Shear (1 work center – shear1) 
- Deburr (1 work center – deburr1) 
- Sanding (1 work center – sand1) 
- Inspection (1 work center – 

inspector1) 
- Weld (1 work center – welder1) 
- Clean (8 work centers – bath1 to 

bath8) 
- Plate (1 work center – plate1) 
- Paint (1 work center – paint1) 
- Assembly (1 line – assembly1) 

The products manufactured require the same types of 
components but vary on the quantity of lamps. The figure on the right shows the typical structure 
of a finished product. The steps for producing the various elements are detailed below. 

Lamp box (1)
Reflector (1)
Socket bracket (2)
Wire chase (1)
Ballast cover (1)
Lamp support bracket (3)
Lens (1)
Ballast (1)

Side channel (2)
End channel (2)

Lens frame assembly (1)

Tube socket (6)
Lamp tube (3)

Finished lamp (FL12345)

Lamp box 
Step Department Standard time / throughput 
1 Saw 5 min/piece 
2 Shear 9 min/piece 
3 Sanding 2 min/piece 
4 Drill 7 min/piece 
5 Inspection 10 min/lot 
6 Weld 5 min/piece 
7 Clean 120 pieces/h 
8 Paint 50 lot/h 
9 Delay 1 h/lot 
10 Paint 45 lot/h 
11 Delay 2 h/lot 
12 Inspection 3 sec/piece 

Channel (side/end) 
Step Department Standard time / throughput 
1 Saw 5 min/piece 
2 Sanding 2 min/piece 

3 Drill 2 min/piece 
4 Inspection 10 min/lot 

Lens frame assembly 
Step Department Standard time / throughput 
1 Weld 7 min/piece 
2 Inspection 10 min/lot 
3 Clean 3 min/piece 
4 Paint 70 lot/h 
5 Delay 1 h/lot 
6 Paint 60 lot/h 
7 Delay 2 h/lot 
8 Inspection 3 sec/piece 

Ballast cover 
Step Department Standard time / throughput 
1 Saw 3 min/piece 
2 Formage 4 min/piece 
3 Sanding 2 min/piece 
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 4 Shear 4 min/piece 
5 Inspection 10 min/lot 
6 Clean 6 pieces/min 
7 Plating 1.2 min/piece 
8 Inspection 3 sec/piece 

Reflector 
Step Department Standard time / throughput 
1 Saw 5 min/piece 
2 Formage 6 min/piece 
3 Sanding 2 min/piece 
4 Shear 5 min/piece 
5 Inspection 10 min/lot 
6 Clean 6 pieces/min 
7 Plating 1.2 min/piece 
8 Inspection 3 sec/piece 

Socket bracket 
Step Department Standard time / throughput 
1 Saw 3 min/piece 
2 Formage 2.5 min/piece 
3 Sanding 1 min/piece 
4 Drill 3 min/piece 
5 Inspection 10 min/lot 
6 Weld 3 min/piece 
7 Clean 6 pieces/min 
8 Paint 20 sec/piece 
9 Delay 1 h/lot 
10 Paint 30 lot/h 
11 Delay 2 h/lot 
12 Inspection 3 sec/piece 

Finished lamp FL12345 
Step Department Standard time / throughput 
1 Assembly 5 min/piece 
2 Inspection 5 min/lot 

The other components are whether subcontracted, whether bought on the market: 
- ballast: receipt of a 25 units lot every 8 hours 
- lamp support bracket: receipt of a 150 units lot every 8 hours 
- tube socket: receipt of a 225 units lot every 24 hours 
- lamp tube: receipt of a 75 units lot every 8 hours 
- lens: receipt of a 25 units lot every 8 hours 
- wire chase: receipt of a 75 units lot every 24 hours 

The sewing machines also necessitate a 15 minutes setup between two consecutive operations. 

The storage space is not a constraint (999999). 

The plant is working on 2 x 8 hours shifts, daily, with breaks of 30 min after 4 and 12 hours 
respectively (the paint, plate and clean departments do not observe these breaks). Furthermore, 
the shear1 machine necessitates a preventive maintenance operation every 16 hours for a period 
of 30 ± 5 min, following a uniform distribution. 

The demand of finished goods is repetitive and 25 units are to be delivered every 8 hours. Sub-
assemblies are launched when the lamp box starts its first routing step. 

Some work centers can treat more than 1 piece or lot at a time: 
- Saw – 5 pieces 
- Sanding – 10 pieces 
- Paint – continuous access, up to 10 lots simultaneously 
- Assembly – continuous access, up to 3 lots simultaneously 

 

Model 
The user should follow the sequential order of the Tabs in the Data Entry Zone in order to respect 
precedence and avoid modeling errors. The only field in the Model which depends of fields of a 
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subsequent sheet, is the Calendar field of the Station Sheet. Indeed, the Calendar Sheet needs to 
be filled before Stations can be attached to the appropriate Calendars. 

One builds the Model by entering the appropriate data into the Sheets of the Data Entry Zone, 
and the Scenarios Zones if he chooses to use the WIP in his Simulation. The user should refer to 
Chapter IV – Data Files, in order to know what type of data the software requires for each field.  

 

Dept Sheet 

The information regarding the Departments of the production system must be entered into this 
sheet. The user must choose a name for each department and indicated their respective capacity 
and cost of inventory per unit and per hour. 

 

Stocks Sheet 

Similar to the Department Sheet, the user must indicate the name of each Storage area and precise 
their respective capacity and inventory cost. 

 

Station Sheet 

This sheet will contain all the information regarding the Stations of the system. The user must 
define each existing Station in the system and associate it to a Department. A rule of selection 
must be attached to each Station. Stations used this rule in order to know which Lot in a queue to 
process next. A capacity must be assigned to each Station. The Batch Type indicates how will the 
parts be manufactured: either by individual piece or by Lot. The capacity refers to the unit used 
(xlots or xpieces or cont). The Max Wait Batch Field indicates the maximum delay to wait before 
admitting a partial batch when the capacity is greater than one and the batch type is xlots. The 
distribution fields concern the time requested to (re)configure the station between two 
consecutive entities having a different setup code. It is possible to assigned a set up cost for each 
machine. The processing time of a lot or piece is multiplied by the factor indicated in the 
PROCEFF Field in order to determine how long it really takes on this station to complete an 
operation. Finally, the user can attach up to 4 different Calendars to a Station. The Calendars 
must be defined beforehand. 

 

Shifts Sheet 

The Calendars will be defined in this sheet. The user must choose a name for each shift and can 
eventually associate an Off Cost to each shift. The End and start Date must be entered for each 
shift. The shifts must then be précised. Please refer to the “Important note concerning Calendars” 
and the “Note regarding ON Fields” of Chapter IV for details on how to define shifts. 

 

Holidays Sheet 
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Each holiday observed by the production system must be entered here. It is possible to assign a 
Holiday to ALL Departments or to only certain of them. An Off Cost can be defined. The Start 
and End Date of the Holiday must be entered. 

 

Exceptions Sheet 

The user must precise a name for each exception and associate it to a Station. It is possible to 
assign an Off Cost to the exception. The Start and End Date of the exception must be indicated. 

 

Down Sheet 

The user must assign each defined Down period to a Station. He must define the On Period and 
the Off Period for each Down. The On Period must be at minimum 0.01. It is possible to assign a 
Cost to the Down Period. The Start and End Date of the down period must be indicated. 

 

Tools Sheet 

The user must defined tools or operators in this sheet. He must also indicate their respective 
quantity. 

 

Parts Sheet 

The user defines the Parts or services produced or provide by the production system in this sheet. 
It is possible to indicate the cost of raw material and indicate the Sales Value of each Part. It is 
also possible to precise the number of Parts in stock at the beginning of a Simulation.  

 

Routes Sheet 

The Routes Sheet contains the production sequence of each Part. The user must define all the 
steps associated to the production of each part. A step must be attached to a department. It is 
possible to use a tool or to assign an operator at each step. The quantity of tolls or operators must 
also be indicated. The user may also define the set up type for each part in this sheet. The 
throughput of the step regarding a precise part will also be defined here. The user has the 
alternative to define the throughput either by Hours per Lot (hpl), Hours per Pieces (hpp) Lot per 
Hour (lph) or by Pieces per Hour (pph). The user can finally indicate the Processing Cost and the 
Added Value of the Step.  

 

BOM Sheet 

The recipes of each part are defined in the Bill Of Material Sheet. The user must precise the 
Assembly (parent) part and the Component (child) part in this sheet. The quantity of components 
will also need to be indicated. Please refer to the launch criteria for the components field of the 
BOM Section of Chapter IV for details on how to use the Launch criteria. 
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Orders Sheet 

The produced Lots (Orders) are defined in this Sheet. The parts (and their quantities) contained in 
each order must be entered here. It is possible to assigned priorities for Lots. A lot can be produce 
either to fulfill an order or for stocks (Lot Type). The Start Date typically indicates the date at 
which the order was received and the Due Date indicates the date at which the Lot is due to the 
client. It is possible to precise a Sales Value of each Lot. Finally, the user can enter the 
information regarding a recurring Lot in this sheet (Please refer to Chapter IV for more 
information on hoe to use these fields).  

 

Supply Sheet 

This sheet refers to supply orders. Similar to the Orders Sheet, the Order name, the Part and the 
quantity ordered must be indicated by the user. The expected reception date must be entered. It is 
also possible to define a cost and to add information concerning recurring orders in this sheet, in 
a similar way than in the Orders Sheet. 

 

Syst Sheet 

The Syst Sheet contains the name of the Model, which cannot be changed (abcmodel), and some 
eventual indirect cost of the production system.  

 

Sheet Headers 

It is possible to change the header of each Data Field in order to customize the Model. One can 
access the tables used to enter the personalized Headers by clicking on the Data Headings Button 
displayed in the Figure hereafter. This will open a table into which the user can enter the 
corresponding user defined headers, as displayed in the next Figure. 
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Data Header 
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User Defined Header Table 
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8.2 Hospital 

Situation 
St. Hippocratus Hospital provides treatments to the county community. The goal of the study is 
to analyze the capacity and the cost related to the operation of its emergency unit and some other 
key services, as shown in the table below: 

 

Department Capacity 
(patients) 

Waiting 
cost ($/h)

Service unit (max. # of 
patients simultaneously 

served by 1 unit) 

Sequencing 
rule  

(# units) 

Setup  
(duration / 

hourly cost) 
admission 100 2 $/h 2 (1) FIFO 36 sec / 1 $/h 

X-ray 10 10 $/h 1 (1) HP 6 min / 100 $/h

laboratory 10 5 $/h 4 (1) 
HP (2) 

EDD (1) 
SPT (1) 

3 min / 10 $/h 

infirmary 30 12 $/h 2 (10) SPT (1) 
HP (1) 36 sec / 1 $/h 

emergency 5 80 $/h 3 (1) HP (2) 
SPT (1) 3 min / 100 $/h

surgery 2 100 $/h 2 (1) CR (1)  
HP (2) 2 h / 500 $/h 

bedrooms 25 5 $/h 

25  
(1 to 5 – 1,  
6 to 20 – 2,  

21 to 25 – 4) 

EDD (3) 
SPT (4) 
HP (5) 

FIFO (13) 

30 min / 25 $/h

 

The three waiting areas have the following capacity respectively : infinite (for the purpose of this 
study), 100 and 100 people. The waiting cost associated with a person waiting in any of these 
areas is 5$/hr. 

Support employees include trainee nurses (20) and assistants (10). 

Previous studies have shown that 97.5% of the patients can be classified in the following 
categories: 
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1.  trauma (priority 1, average cost $1,500, interarrival rate triangular 0.25, 2, 12 hours) 

 
 

STEP # TYPE DEPT ASSISTANTS QTY REQ. THROUGHPUT (dist) T1 T2 T3 UNIT COST ($/h)
10 xray_exam admission CONS 15 lph 10
20 xray_exam waitingArea1 CONS lph
30 xray_exam emergency UNIF 12 5 lph 200
40 xray_exam waitingArea2 CONS lph
50 xray_exam Xray CONS 2 lph 75
60 xray_exam emergency UNIF 12 3 lph 230

2.  X-ray exam (priority 4, average cost $100, interarrival rate exponential 1 hours) 

 

STEP # TYPE DEPT ASSISTANTS QTY REQ. THROUGHPUT (dist) T1 T2 T3 UNIT COST ($/h)
1 lab admission CONS 15 lph 10
2 lab waitingArea1 CONS lph
3 lab emergency NORM 0.5 0.1 hpl 200
4 lab waitingArea2 CONS lph
5 lab lab nurse 1 CONS 7 lph 17
6 lab emergency NORM 12 2 lph 200

3.  Lab exam (priority 5, average cost $35, interarrival rate triangular 3, 15, 60 minutes) 

 

STEP # TYPE DEPT ASSISTANTS QTY REQ. THROUGHPUT (dist) T1 T2 T3 UNIT COST ($/h)
1 surgery emergency TRIA 0.25 1 3 hpl 450
2 surgery waitingArea2 CONS lph
3 surgery lab nurse 1 CONS 10 lph 25
4 surgery waitingArea3 assistant 1 CONS lph
5 surgery surgery_dept UNIF 5 2 hpl 750
6 surgery waitingArea3 assistant 1 CONS lph
7 surgery infirmry nurse 1 UNIF 1 0.7 hpl
8 surgery bedrooms NORM 240 96 hpl

4.  Surgery (priority 2, average cost $15,000, interarrival rate uniform 10 ± 3 hours) 

 
STEP # TYPE DEPT ASSISTANTS QTY REQ. THROUGHPUT (dist) T1 T2 T3 UNIT COST ($/h)
100 aches admission CONS 10 lph 10
200 aches waitingArea1 CONS lph
300 aches lab nurse 1 CONS 12 lph 15
400 aches infirmry nurse 1 UNIF 4 2 hpl 5
500 aches waitingArea3 assistant 1 CONS lph
600 aches bedrooms TRIA 24 72 144 hpl

5.  Chronic and minor aches (priority 3, average cost $60, interarrival rate triangular 15, 30, 
75 minutes) 

 

STEP # TYPE DEPT ASSISTANTS QTY REQ. THROUGHPUT (dist) T1 T2 T3 UNIT COST ($/h)
1 trauma emergency UNIF 0.5 0.1 hpl 300
2 trauma Xray CONS 3 lph 100
3 trauma lab nurse 1 CONS 5 lph 50
4 trauma emergency UNIF 1 0.25 hpl 150
5 trauma waitingArea3 assistant CONS hpl
6 trauma surgery_dept TRIA 2 4 6 hpl 800
7 trauma bedrooms TRIA 24 96 240 hpl 18
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Supplies are not a constraint except for blood and plasma supplies. The inventory contains 100 
units initially. A shipment of 100 units is to be received every week (15 $/u). Upon reception, the 
units are checked and marked about 30 minutes (per unit received, and at a cost of 12 $/h) in the 
laboratory before being sent to a special storage area that can hold up to 1000 units. Trauma 
patients necessitates on an average 4 units while surgery patients will require 15. 

 

The modeling process for this model is very similar to the one used in the previous example: 

1. fill department and waiting / storage areas forms 

2. create individual units of services taking into account their individual sequencing rule 

3. add support resources (nurses and assistants) 

4. define the patient types 

5. enter their treatment patterns in the routing file 

6. consider the blood requirements in the BOM file 

7. add patients arrival and blood supplies patterns 
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